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1. Video Camera - Windows
Media Encoder

Examples of video cameras that can be viewed using WebAccess include the
Logitech series of cameras. These cameras are usually USB devices that
connect to a PC.

Windows Media Encoder broadcasts the live video over a TCP/IP connection.
Windows Media Encoder (version 9 is recommended) should be installed on
the PC connected to the video camera.

1.1 Download Windows Media Encoder

Windows Media Encoder (version 9 is recommended) should be installed on
the PC connected to the video camera. You can download this at no charge
from Microsoft. The general (and shorter) address is:

http://www.microsoft.com/downloads/search.asp

The Link to the Media Encoder download is:

http://www.microsoft.com/windows/windowsmedia/9series/encoder/default.a
sp?FinishURL=%2Fdownloads%2Frelease%2Easp%3Freleaseid%3D42209%2
6area%3Dtop%260rdinal%3D6%26redirect%3Dno

The ENCODER should not be confused with the Player. You need Windows
Media Encoder in order to broadcast Live Video over the Internet from your
camera. (You can use media player to view from another PC).

1.1.1 CPU Loading

Media Encoder will take up a lot of CPU resources (100% on a 750 MHz
Pentium 5). Itis not recommended to use a SCADA Node or Project Node as
the Media Encoder PC without first staging and testing for CPU load (except
for a DEMO or training).

1.1.1.1 System Requirements

In general the system requirements are Windows 2000 or Windows XP, 300
MHz minimum, 866 MHz recommended for capture and broadcast of Video
and Audio. The Microsoft recommended system Requirements for capture and
Broadcast of Video using Windows Media Encoder are at:
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http://www.microsoft.com/windows/windowsmedia/9series/encoder/relnotes.
asp#sysreq

1.2 Configure Windows Media Encoder

After you have installed Windows Media encoder, you have to start, and
configure media encoder to select the camera, TCP Port to broadcast over and
other details. As always, we recommend that you use the default setting
whenever in doubt.

This example is for a Logitech Camera that is plugged into a USB port. But
any camera with Plug-n-Play capability with Microsoft Windows will work.

Windows Media Encoder must be running in order for other computers to see
the camera.

200 Professional

o

Forrmat

MMstart | | @ 5 ) © || @ ntitled - Windows Media .| F)untiled - paint |

Step 1 - Start Windows Media Encoder

1. From the START menu select

Start -> Programs -> Windows Media -> Windows Media Encoder
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New Session : _?‘I_)Ei
Wizards | Quick Starts |
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sesgi0n o video devices of compubes soreen,
Caphure
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Step 2 - Select Broadcast a Live Event

2. Select Broadcast a Live Event.

New Session Wizard i Lli

Device Dptions
Salec] the devicas Lo ute lor encoding sudio and video in thes setsion. Dinly cumanthy
instaled devices are ksted.

‘wihat denices do pou want by use?

¥ Wideo:  [Logtech DuickCam'wWeb =] Conigue.. |

delsull vadeo dewice
e IR — |

'T'p‘ < 1 Sy L = - - - L
@ Chick Corifigues o sat propesties for the selected device.

< Bach Hesd > Firigh I Cancel I

Step 3 - Select your camera - Logitech Quick Cam shown

3. Select your camera from the pulldown list next to Video. Be sure the
checkbox is checked to enable Video broadcast.
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4. Optionally select the Sound Card from connected to your microphone from
the pull down list to audio.

5. Select Next.

New Session Wizard lll

Broadcast Method

“ou can broadcas] content by puthing il to & Windows Media served of by allowing
players or \Windows Medsa servers lo pull diectly from the encodes.

Haosw dio pou want bo bioadeast you encoded conterd 7

ﬂ_ﬂ] ™ Push to a Windows Media serves [the connection is initizbed by the encoder)

@ 1+ [Pulliram the encodes [fhe sarver or player iniisles the cornechion]

Tp :
@ Fot inforrastion sbout sailing up & push distibulion session, 2 Help,

<Bock [ Mea> | rer | cos |

Step 6 - select Pull from the encoder

6. Select Pull from the encoder (the server or player initiates the
connection).

7. Select Next.

Version 3.0 rev 0 Broadwin Technology, Inc. page 4



WebAccess Driver Guide Windows Media Encoder

Mew Session Wizard i x|

Broadcast Connection
Salect the port thecugh which players and Windows: Media servar: can accass the
Hrearm.

‘What port do you want to use?

HTTP pat BT Find Free Pt |

UIRL for Irtemet connections: ]me1 1061 64130 BOED

LIRL fon L&N connections: ]Htpc.fm.ammﬂmm

Tp
@ 'ou can copy the URL and peenade it ba usess 20 they can sccess the slresm,

<Back Next > Fish | Coneal |

Step 8 - enter a TCP Port - 8080 is recommended default

8. Enter a TCP Port for the Video Broadcast. 8080 is the recommended
default.

9. Select Next.

Mew Session Wizard ]

Encoding Ophlions
Select encoding seftings fos your content. Your selections determine settings such as
bit 1ate, frame rate, and buffer sze.

Howe do yous want to encode wouwr audio and video?

Video: II'-'IuIipIc bit rates [CBR: 11k - 384) "‘:I
Audio: |t uiiple bit rates audio [CEF]
Bil sate: T [T | Output Size | _if
On2eo2kbps 2997 fps 320w 240
Cl76403Kbps 2957 fpe 320 % 240
[ 54202 Kbps 2997 fpe 320w 240 j
Tip

¥ ‘Y'ou can adiust setiings on the Session Propeities parel after you complete
8 thee: wizard,

cBack [ News |  Fiish | Concel |

Step 10 - Accept default, Multiple bit rates (CBR: 11k - 3M)

Version 3.0 rev 0 Broadwin Technology, Inc. page 5



WebAccess Driver Guide Windows Media Encoder

10. Accept the default for Video Encoding: Multiple bit rates (CBR: 11k -
3M)

11.0ptionally accept the default for Audio Encoding: Multiple Bit Rates
(CBR)

12. Select a Bit Rate: the 282 Kbps 29.97 fps and/or 141 Kbps 15 fps
13. Select Next.
Mew Session Wizard x|

Archive File
Yot can creale an aiche e of the brosdcadt

I nchive & copy of the broadeast b fila]

< ok Heot 3 Firish Cancel |

Step 14 - do not archive

14. Do not archive unless you have a very, very large amount of disk space
and CPU seed. Video will create very large files rapidly. It is recommend to
accept the default (uncheck Archive).

15. Select Next.

Version 3.0 rev 0 Broadwin Technology, Inc. page 6



WebAccess Driver Guide Windows Media Encoder

Step 16 - don't include video files

16. Select No, I want to encode from my selected devices only.

17. Optionally enter Title and Author information. Select Next.
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e sessionwizors x
Setlings Aeview
Fessw sollnge: lor lhis sasion. Chek Fresh b el up the teson of chek Back lo
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Lt
Coppenghi:
Hating
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L
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Step 18 - Finish

18. Optionally select Begin broadcasting when I click Finish. Select
Finish.

T imaRbed - Wi Medka Eresder

iR =10lx|
[ Ywwe Contrdl [aok Help
Hrewdman W L] Propeites ﬂﬁaltn-cm_lj [ ]

Figure - Media Encoder Capture, but not broadcasting.

19. If you see only the Window on the left with an image, but the Output

Window on the right is blank, then you are not broadcasting. Select Start
Broadcasting.
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By ivaaled - W Meds Fraacdes

Figure - Widows Media Encoder - capture and broadcast images

20. If both windows show an image, Congratulations! You have successful
setup Windows Media encoder.

21.To lesson system load, you can close the local display of video images
from the menu bar:
View -> Video Panel

Un-checking Video Panel will display windows, but continue to close
capture and broadcast video (and audio).

22.Save the setting from the menu bar: File -> Save
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2. Configure Video in
WebAccess

There are two general ways to add your newly configured Windows Media
Player to the Web:

1) Configure Video on a SCADA Node. There is no display building
required. The Camera appears full screen in WebAccess VIEW. This is
done from SCADA Node Properties.

2) Draw a Dynamic Video object in a Graphic Display using DRAW. You can
mix your Video with animation trends etc.

]ll...ul.-.'. T v euh Ve S il it |l - m .y
TR e Fort Tk =
wetad v = () [ D et lfeertn @rada e KR o 0

el LT e o e RTINS AT e L o T B M | e Dl i B ] Bl A ] = o
LIVEDEWD [scanaizdsl ERADH=V.dacaixsd, bgr

F2| FY | Fa| P | FE | P8 | F8 | FI0[F1 [F2 F5 wm| | 8| F7 | FO| RO FIO|

=N EE [Fidsomixed.bagr Video in Graphic |15523:56

Figure - Live Video mixed with animated graphics, real-time data and trends
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21 WebAccess Video configuration

This section assumes the camera is on-line and functioning. Please refer to
the camera manufacturer's documentation on how to start the camera and
assign an IP address to it. The WebAccess Clients communicate directly to
the camera. The IP address of the camera must be available to all the
WebAccess clients that are to view the camera.

1.

2
3.
4

From the Project Manager, Select your Project and the SCADA Node.
Click the Video hyperlink.
Select Add Video hyperlink.

. The Add/Update Video page appears.

Update Video  [Cancsl

Videa Mame  [Ev_ofiice

Diescription |1 0 zecond delay

Local TagFile | Tag File List | |
On Entry | Seipt File List [ =
Local ;
Seript File OnEet |
While Showing | Interval 12U (10=0.25 Second]

Vidaa Type  |mplaver (dindows Media Ercoder) =]

Vidao IP Addrass  [66.106.164.130 Port Mumber  [2080
Camera ot Used
31 File

I
Sound GEIFe  [riotLUsed
I

Audio Parareter GG File

[Cancel] Subrnit |

Figure - maplayer (Windows Media Encoder) video type

Video Name. Enter a name that will appear in Dialog Boxes used by
operators and users.

Description. Enter a description that will appear in the project manager.
Video Type. Select mplayer (Windows Media Encoder).

Video IP Address. Enter the IP address of the PC running Media
Encoder. This address must be accessible by WebAccess VIEW clients
directly.
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9. Port Number. Enter the TCP port assigned to the camera. 8080 is the
default port number for most Media Encoder and the port humber used in
the above setup instructions.

10. Local Tag File. Optionally, screen tags can be associated with the Video.
These are a Local Tag file configured DRAW. These allow a screen script
to use Local Tags for rotating between video cameras or other
customization.

11. Local Script File. Optionally, screen scripts developed in the script editor
of DRAW can be used to rotate between video cameras or other
customization.

a.

On Entry is a screen script that executes once when the Video Display
is called in VIEW.

On Exit is a screen script that executes once when another Display is
called and this display is exited in VIEW.

While Showing is a screen script that executes continuously at the
specified Interval while this Display is displayed in VIEW.

Interval is the frequency the While Showing Script repeats.
Press SUBMIT.

Download and Start your SCADA node.

Note -

You do not need to configure Video on the SCADA Node is you are only planning to show
Video mixed in a Graphic Display with animation. You can configure video in DRAW
directly. However, the pull down lists make Video configuration on the SCADA node
easier than in DRAW.

Version 3.0 rev 0
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211 VIEW Video Cameras

In VIEW and ViewDAQ, operators and users can call up a Dialog Box that lists
all the cameras configured. Pushbutton Keymacros built by engineers and
technicians in DRAW can open a VIDEO camera window.

The Video cameras are viewed in an Internet Explorer 6.0 or later web
browser. Even if using ViewDAQ, Internet Explorer must be installed on the
clients in order to view cameras. Video requires Windows 2000 or Windows XP
Professional.

LiveDEMO | SCADAnodel GRAPH=VideoZ. bgr

FA|F2| F3|F4|F5|F8|F8|Fa|F?|FT[FI[F2[F3[F5 =

. . Wiaw aquipment and facitlas Ina wab browsaear,
lee Vldeo Opes mittiple wihidows toulew m aHiple came @s, sma HAgEors by,
Wideo wihdow scaks (hcreashigm ags Hkcaton ).
Live VIDE O File »
Ercaduvin Offioe o )
Ban Franoleoo LUBA Edit » fi=noe S=nisc
Viegw #
Live wideo of Offlce Bullding Entry. Chan q
& # & Civerview F1
B N e - Mrr I T E1

Livws| icabvfo gl BL—Ld_Jta, i : 4 Faceplate... F2
Realtime Trend... F3
Datalog Trend.., F4

aa | Alarm Summary  FS
Alarm Group. .. Fi&
Recipe... F&
3 araph.., Fa
| ST a2

Wideo. ..

Clck on mage orpistbattos to open Ibe wid

Press o opan EBlack Dekail F7
Two VIDE O Windows Pairt Detail Shift+F7

Ban Franolsoo UAA
=

Talwan

Station Status ChrH-F7
I hdows 2000 or %P recom mesded Libe Wideo demo. Alarm Log Ckrl+FS
DSLortaste reor iection 3lEo recomme vded forthe Wideo dem oF .

Aition Log ChrH-FO B
ray ‘ SFP1 16  UserPrograms  ChrHFI0 )
Paink Infa... Ckrl+FS
[&1 Done ol Eoint Gobo of: [

21.2 Single Video Display

No display building is required to view a configured Video Window. The
Camera will appear full screen if called from the Video List Dialog Box <F10>.

The <F10> key macro and the Menu Item (Right Click -> Goto -Video)
display a list of all configured cameras. Pick the desired camera form the list
and it will appear in full screen.

Popup Windows can be built using the <GOTO>URL Keymacro.
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21.21 Video Dialog Box - F10

In VIEW and ViewDAQ operators and users can call up a Dialog Box that lists
all cameras configured for the SCADA node. There are several methods to
call up the Video Dialog box.

F10 function key on keyboard.

<F10> keymacro assigned to a pushbutton on a user built display.

<F10> on a toolbar.

<DIALOG>VIDEO assighed to a pushbutton on a user built display.

Right Click Menu -> Goto -> Video

¥ideo List

Fath: IF:HWEI:.-'-‘-.CDESSHN odebLiveDEMO_SC

Mo, File Hame

1 E:['I T_TE;;_"-',_ . ‘:_."lj_lj
2 TW_HIGHWAY . wdo

Viden File:

] I Cancel |

The Video List Dialog Box will display the Camera in VIEW or VIEWDAQ
window (i.e. full size).
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2.2 DRAW Video in a Graphic Display

Video can be added to user built Graphic Displays and mixed the real-time
data, widgets, trends and animation.

i
i ot e :
domat - = D[] G} Dk et fede 3 e G K- d 0
e T t 3 et IVETNPA =S AT 3 | T Dt M g D O T ] B = :FB
LIVEDERD [scApanzdal GREAVH=V.dacaizad. bgt
Fi|F2| P8 FA|FS) P8 P8 PO |FIOJF1 [F2[F3 [FS || FE| F7 | FR| PO (FIO]
Acknowbedge T T
LA LT
I EIRNE:E =S [Vigsomived.bhar Videos 1n Graphic Ji5: 23156

Figure - Live Video mixed with animated graphics, real-time data and trends

Multi-camera Displays, including live tag data and trends are user-built
graphic displays. Scripts can rotate between cameras in the same window,
pause or jump ahead to another camera with pushbuttons.

Multi-camera Displays, including live tag data and trends can be built in
DRAW using the Dynamic -> Video Display from the toolbar
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*| ddress [B] v [fdemo.bromdven. comibr oaditebsystombwave a5 Tpro-LveCEMOBOde=SCATANOde | Bogt=Ditres =] (6o |

LiveDEMO |ScaDAnodel [videoLARGE. drw |

Videa: Ir#ip=EE.'I 0E.164.130%port=2020

k. I Cancel |

|P«.BC |L ] |Em1

gwlolﬁlel-l-lvlulﬂ@gygﬁﬂ|

[E]vere [T [ tteemest =

Figure - DRAW DYNAMIC VIDEO window in a user built Graphic Display

X 86[¥ 816

To configure the Video Display in a User Built Graphic.

1.

Right Click the Mouse (DRAW) (or select from Menu Bar (DrawDAQ))
select

Dynamic -> Video Display

Enter a Name for this Video Window. This will allow scripts and animation

to change which camera is displayed in this window. (If you previously
edited or drew a Video Display, these fields will have the data from the
last Video Display edited).

Enter the Video Driver name, the pound sign (#) and the IP address of
the Video Camera or PC with Media Player. For example:

mplayer#ip=66.106.164.130&port=8080
Select OK .
Click once to define the start of a rectangle

Drag with the mouse to define the size of the Video Window in the
Graphic.

Click a second time to define the end of the rectangle.
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3. Advanced Video: Popups,
Tips, Scripts,

3.1 Video Popup
3.1.1 Key Macro <GOTO>URL

To open the Video is a separate Popup window, with the ability to control the
size and position, use the <GOTO>URL keymacro. It is recommended to use
this in a Keymacro file and then call the keymacro file from a pushbutton.

1. Configure a keymacro file named, HwyCamera2, with the following
keymacro:

<GOTO>URL=http://66.106.164.175/broadWeb/system/bwviewpg.asp?pr
0j=LIVEDEMO&node=SCADANodel&tool=0&stat=0&goto=webctrl=tw_hig
hway.vdo~target=video2”height=400"width=450"left=470"status=0/t
oolbar=0

2. Assign a pushbutton with the keymacro to call the keymacro file:

<MCREXEC>@Hwycamera2.mcr

3.2 Video Tips
3.21 Screen Capture

The Alt-PrtScn (Alt Print Screen Key) does not reliably capture Windows
Media Encoder Video images.

To capture a Screen, make it full size then use PrtScrn (Print Screen) key
on your keyboard.

3.3 Video Script Examples

Scripts can be built to popup a window, goto a full page or, rotate cameras

3.3.1.1 Open Video Popup script

The following is a Screen Script associated as the "While Showing" Script for a
Video Display. It opens a Video Camera Popup based on a Digital Tag.

if {[GETVAL Digtag] == 1} then {
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cole;

URL=vdo: at opl c#i p=202. 178.

t =480"1 ef t =100t 0p=50
}

230. 25&por t =0"t ar get =t wn*wi dt h=640"hei gh

3.3.1.2 Change cameras every minute

The following is a Screen Script associated as the "While Showing" Script for a
Video Display. It rotates between 3 cameras. It uses a local tag file with

screen tag named count.

SETVAL "count =%°LUS 1"

if {[GETVAL count] > 60} then {

SETVAL "page=%.OOPPLUS 1"
switch [ GETVAL page] \

1" {GOTO URL=vdo:
"2" { GOTO URL=vdo:
"3 {GOTO URL=vdo:

"default" {GOTO URL=vdo:

SETVAL count =0
}

canvi ew c#i p=210. 128. 176. 51} \

at opl c#i p=66. 106. 164. 161&port =0} \
at opl c#i p=202. 178. 230. 25&port =0} \
at opl c#i p=202. 178. 230. 25&port =0}
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3.3.1.3 Pushbuttons and Rotate Multiple Cameras

This script is designed to rotate the Cameras displayed in Video Display
windows named al every 60 seconds. Pushbuttons set Toggle (VideoOff) to
turn off the display of video and VideoHold to pause the rotation between
cameras. Use Dynamic ->Video and name it al.

proc swtchvideo {argl} {
switch $argl \

"1t { SENDVDO
al=axi scanm#i p=sprout.warw ck. ac. uk&cgi =cgi - bi n/ nj pg/ vi deo. cgi }
\

"2" { SENDVDO
al= nplayer#lp 66. 106. 164. 130&por t =8080} \

{ SENDVDO al=at opl c#i p=66. 106. 164. 161&port =0} \

" 4" { SENDVDO al=at opl c#i p=202. 178. 230. 25&port =0} \

"default" {SENDVDO "al=vi deoof f #msg=Pr ess Rot at e Caner as
button to rotate thru canmeras."}

}

if {[GETVAL toggle] > 0} then {
SETVAL "t oggl e=0"

if {[GETVAL videooff] == 0} then {
SETVAL "vi deoof f=1"
SETVAL "count ol d=@ount"
SETVAL " pageol d=@age"
SENDVDO "al=vi deoof f #nsg=Press ' Video On' button to show
vi deo. "
} else {
SETVAL "vi deoof f =0"
SETVAL "count =@ount ol d"
SETVAL " page=@ageol d"
swi tchvi deo [ GETVAL page]
}
}

if {[GETVAL videooff] == 0 && [ GETVAL vi deohol d] == 0} then {
SETVAL "count =9°LUS 1"

if {[GETVAL count] > 60} then {
SETVAL "page=% OOPPLUS 1"
swi tchvi deo [ GETVAL page]
SETVAL count =0
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